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Welcome to Slicerd
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> Admowledgment

To start Slicer, double-click on the Slicer-shortcut icon on the
Desktop (bottom left)
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Navigating the Application GUI

The Graphic User
Interface (GUI) of Slicer4
integrates four
components:

* the Menu & Toolbar

* the Module GUI Panel
* the 3D Viewer

* the Slice Viewers

pboo 3D Slicer 4.4.0
Za Modules: |\ Welcome to Slicer o] - Menw & ROIbar ~| Bt~ Ao R 8e
r‘/ Slicer

G Load DICOM Data
s Customize Slicer

==, Load Data

~ Feedback
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Slice Annotations: |
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& Download Sample Data

and let us know
about ho w 3D Slicer has enabled your
h.
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ﬁ' Welcome to Slicerd.4

£ 30 Slicer4.40 4 ACPC Transform 4 Fiber Bundle to Label Map 4 Resample Scalar Volume |
File Edit View Help #& Add Scalar Volumes £ fiber_visibility_crash2438 #& Resample Scalar/Vector/DWI Volume \
@ Modules: 2\ Welcome to Slicer 2| (4 AddManyMarkupsFiducialTest #& FiberBundleLabelSelect 4 Resize Image (BRAINS)
All Modules [ @ Annotations 4 Fiducial Registration & Robust Statistics Segmenter
& AtlasTests 4 FiduciallayoutswitchBug1914 4 RSNA2012ProstateDemo
@ Annotations
oat + BRAINS Strip Rotation + Foreground masking (BRAINS) 4 RSNAQuantTutorial
ata
o BRAINS Transform Convert + Gaussian Blur Image Filter 4 RSNAVisTutorial
Datastore
2 otcom & BRAINSDWICleanup 4 General Registration (BRAINS) B sample Data
Wel CO | ” i & BSpline to deformation field & Gradient Anisotropic Diffusion 4 Scene Import (Issue 2428)
tor
@ Cameras & Grayscale Fill Hole Image Fiter 4 Scene Performance
Markups
- © Hodel o Cast Scalar Volume +# Grayscale Grind Peak Image Filter A Scene Views
odels
[oicoiy Load DICOM & Charting & Grayscale Model Maker & Selffests
 Scene Views
4 customize Shic , # CheckerBoard Fiter 4 Histogram Matching ke Simple Fitters
= Subject Hierarchy
B Colors 4 Image Label Combine 4 simple Region Growing Segmentation
@ Transforms
~ Feedback # ColorsScalarBarSelfTest & RC2013vis # SliceLinkLogic
M View Controllers
o Compare Volumes +# Label Map Smoothing & Sliceraminute
@ Volume Rendering
& Create a DICOM Series 4 Label Statistics # siicerCloseCrashBug2s90
- Share your stories (@ Volumes §
& Crop Volume & Label Statistics (BRAINS) Subject Hierarchy
B\ Welcome to Slicer
& Curvature Anisotropic Diffusion 4 labelToggleBug2049 4 SubjectHierarchyCorePluginsSelfTest
We are alvays interested in improv| .
zards Data # Landmark Registration # SubjectierarchyGenericselfTest
Se  mformatics DataProbe Markups # Subtract Scalar Volumes
»
> About Registration Datastore & MarkupsinCompareViewersSelfTest % Surface Toolbox
Segmentation »
+ Demon Registration (BRAINS) MarkupsTnViewsSelfTest Test Tractography Display
» The Main Window Quantification »
DICOM Mask Scalar Volume Threshold Scalar Volume
Diffusion > 4:0.000mm
» Loading and Saving r ,|# Diffusion Tensor Scalar Measurements o4& Median Image Filter Tractography Display
R Filtering »|# Diffusion Weighted Volume Masking 4 Merge Models + Tractography Interactive Seeding
Displa
— Surface Models DTlexport o4& Metric Test + Tractography Label Map Seeding
» Mouse & Keyboard Converters oTImport 4 Model Maker & Transform MRML Files to New EMSegmenter Standard
Endoscopy DWI Joint Rician LMMSE Filter 4 Model To Label Map % Transforms
» Documentation & Tutorials Utilities DWI Rician LMMSE Filter @ Models 4k Vector Demon Registration (BRAINS)
» Acknowledgment Developer Tools *|#& DWIto DTI Estimation #& Multiply Scalar Volumes & Vector to Scalar Volume.
Legacy *| & DWIto Full Brain Tractography MultivolumeExplorer B View Controllers

Click on Welcome to Slicer to display the list of
modules of Slicer in the Modules menu and click
on All Modules
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ACPC Transform General Registration (BRAINS)

Add Images. Gradient Anisotropic Diffusion

© Annotations Grayscale Fill Hole

BSpline to deformation field Grayscale Grind Peak

Cameras Grayscale Model Maker

Cast Image Histogram Matching

ChangeTracker Image Label Combine

CheckerBoard Filter Intensity Difference Change Detection (FAST)
Colors Joint Rician LMMSE Image Filter

Create a DICOM Series Label Map Smoothing
Crop Volume Label Statistics
Curvature Anisotropic Diffusion Linear registration
DICOM MR Bias Field Correction

DWI to Full Brain Tractography Mask Image

Mask from Diffussion Waishtad Images

‘ommand-iine

i EMSegmenter with Atlas

& EMSegmenter without Atlas

Editor

Endoscopy

Event Broker

Execution Model Tour

Expert Automated Registration

Extract Skeleton

Fast Affine registration

Fast Nonrigid BSpline registration
on

oh

ng (BRAINS)

ime With Model (Paint)

Resampl
Resample Scalar Volume

Resampie Scalar/VeclorfOWi Voiume
Rician LMMSE Image Filter

Statistics Segmentation
putation

« Scene Views
Simple 10 Test
Simple region growing

Tractography Labelmap See:

Transform MRML Files o N

Transforms

Unbiased Non
View Controllers

© Volume Rendering

@ Volumes g

Voting Binary Hole Filling b

Welcome 1o Slicer

EMSegmenter Standard i

Al Means filter for DWI

Slicer4.4 contains
more than 100
modules for image
segmentation,
registration and 3D
visualization of
medical imaging data
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Loading a DICOM Volume
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,ﬁ) Loading a DICOM volume

Drag and drop the directory ‘dataset1_Thorax_Abdomen’ into Slicer

Q oSlicer
Welcome
@@ Load DICOM Data iy Load Data
. d: (l:(ustomize Slicer © Download Sample Data | 4 ‘ 3DVisua|ization_M on day_Decl
~ Feedbad

_ Share your stories with us and let us know about how 3D Slicer
has enabled your research.

We are always interested in improving 3D Slicer, and every submission
will be carefully read.

See more at http://goo.qgl/6BvcHm.

| » About

| » The Main Window

. dataset3_Liver

. datasetd_Chest

| » Display

| » Mouse & Keyboard

Quantitativelmaging_Tuesday_Dec2

|
\
‘ » Loading and Saving ‘
|
|
|

| » Dacumentation & Tittarials
| ~ Data Probe

Slice Annotations: | ' |

L
F
B
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Loading a DICOM volume

& 3D Slicer4.4.0
File Edit View Help
&a & Modules: . ™ Welcome to Slicer it
r‘.’\ Slicer
Welcome
s Load DICOM Data s Load Data

# Customize Slicer © Download Sample Data

~ Feedback

_ Share your stories with us and let us know about,

how 3D Slicer has enabled your research.

We are always interested in improving 3D Slicer, and every
submission will be carefully read.

See more at http://goo.gl/6BvcHm.
» About

» The Main Window

EVO & Z. t - o Se 18 A

Select a reader R ==
Select a reader to use for your data?
Load directory in{®

A pop-up window to select the DICOM reader appears: the
option Load directory into DICOM database is selected by

default.uCIick on OK

L ] 10cm

L ] 10cm
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Loading a DICOM volume
The DICOM Browser appears

A pop-up window appears, click on Add Links

Start Li
~ DICO

StudyID StudyDate StudyTime A

erApp-real =

~ Recent

Do you want to copy the files to the local
0 series database directory or just add the links?

Don't show this message again

R: 0.000mm [# (5 S A: 0.000mm

] »

SeriesNumber SeriesDate SeriesTime SeriesDescription Modality BodyPartExamined AcquisitionNumber Conti

~ Data P|

>

Slice An Load |Metadata Advanced | ' Horizontal | | Browser Persistent

-

j 10cm
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Loading a DICOM volume

£ 3D Slicer 4.4.0
File Edit View Help
& Modules: . #DICOM = Q. E VO & 7 t - fo Fo, Ml = K

@ S| v’;:;::mExport Query Send Remove Repair » o S
Patients: Ao Al - =

» Help &| o . . .

e ez Slicer starts importing the DICOM images

from the directory

~ DICOM
StudyID StudyDate StudyTime cC ReferringPhysician Perf

v Recent] %%%%%* 20050 5 Siicerapp-real =
C:/Users/Administrator/Desktop/3DVisualization_Monday_Dec1/3DVisualization_Monday_Decl/datasetl_Thorax_Abdomen/IM-0001-0062.dcm

1 series
e
Today: ¢ 77777777777777) 21%
Cancel
5
SeriesNumber SeriesDate SeriesTime SeriesDescription Modality BodyPar Conti
6 2005-06-01 120000.000000 CT_Thorax_Abdomen cT HEART 14 APPLIED
~ Data P| [« 5

Advanced ' 'Horizontal ' ' Browser Persistent

Slice An| |_Load |Metadata

-n

Most recent DICOM Database addition: Sat Nov 29 17:36:57 2014

A: 0.000mm




Loading a DICOM volume

B 3D Slicer 440
File Edit View Help
£a [Modules: . & DICOM ¢ ™ EPO % z t- 8w Rl B®

1s:0.000mm | =' 1 &

@ Slicer

» Help & Acknowledgement

~ Servers

Start Listener
Start Listener when Slicer Starts

~ DICOM Database and Networking
Show DICOM Browser
~ Recent DICOM Activity

1 series added to database in the past hour
Today: CT_Thorax_Abdomen for patientl

7| DICOM Directory Import ==

@ Directory import completed.

1 New Patients
1 New Studies ) 10cm
1 New Series

290 New Instances

Click on OK once the
Directory Import is completed

Refresh

~ Data Probe

Slice Annotations:| *

-

! ] 10cm
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Loading a DICOM volume

& 3D Slicer4.40

File Edit View Help
2a & £ [Modules: . #DICOM 2= Q. EPO & & 2 t-E e - @ @

The patient1 DICOM
dataset appears in the S B

Import Export Query Send Remove Repair »

D I C O M b rowse r. Patients: @ Studies: @ Series: Q

PatientsName PatientID PatientsBirthDate PatientsBirthTime PatientsSex PatientsAge PatientsComments
patientl patient_ID

e® MR s:0.000mm | = ] &

StudyID StudyDate StudyTime ReferringPhysician Perf
VOI u I I le 6936864 2005-06-01 120000.000000 6936864 OEfZQhRSY...0)~zlaldx

C h
I Thorax omen '
—_— —
SeriesNumber SeriesDate SeriesTime SeriesDescriptiol Modality BodyPartExamined AcquisitionNumber Cont
6 2005-06-01 ;000,00000 CT_Thorax_Abdomen cT HEART 14 APPLIED
Refresh ‘
~ Data Probe

Slice Annotations: |

Click on Load to load the DICOM volume into Slicer

»

Advanced | ' Horizontal | ' Browser Persistent

_ i} ‘ ‘ [X]
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Loading a DICOM volume
53D Slicer 440 fele =
File Edit View Help
o 2 —+wansa Click on the Slicer layout
e, Licon and select &
Conventional _

o

B OSlicer

» Help & Acknowledgement

e B Four-Up

“|E# Four-Up Quantitative
E Dual 3D

& Triple 3D

3D only

[l One-Up Quantitative
[ Red slice only

[ Yellow slice only

~ Servers
Start Listener
Start Listener when Slicer Starts

~ DICOM Database and Networking

Slicer displays the axial,
coronal and sagittal slices
of the DICOM dataset in a
Four-Up layout (note this
may take a few minutes)

Slice Annotations: |

[ Green slice only
Tabbed 3D

[ Tabbed slice ‘
/Y= Compare »

'A: 169.254mm

M Compare Widescreen ’ e
B Compare Grid

B Three over three

M Three Over Three Quantitative
@ Four over four

H Two over Two

M Side by side

E Four by three slice
M Four by two slice

B Three by three slice

B B: 6: CT_Thorax_Abdomen

B: 6: CT_Thorax_Abdomen

LT

©2014 Surgical Planning Laboratory, ARR Slide 33



Loading a DICOM volume

SRR

File Edit View Help
% & g |Modules: . |%DICOM (=009 & & v t-E |+ @A

e®
@ 30Slicer

[ » Help & Acknowledgement

I ~ Servers

[ Start Listener l
Start Listener when Slicer Starts

[ ~ DICOM Database and Networking

[ Show DICOM Browser J

[ ~ Recent DICOM Activity

0 series added to database in the past hour
Today: CT_Thorax_Abdomen for patient1

Refresh

[ ~ Data Probe

Slice Annotations:

%

Slicer displays the axial, coronal and sagittal
slices in conventional viewer mode

(]

©2014 Surgical Planning Laboratory, ARR Slide 34



Loading a DICOM volume

(B 3D Siicers 40 & =]
File Edit View Help

ga o Modules: . #n1com -
= el All Modules »

Annotations
3DSlicer
e 4 Data

D, e
* Help & Acknowledgement

=
‘ 2 DICOM
~ Servers 2 Editor
“. Markups
Start Listener when Slicer @ Models
- DICOM Database and Ne{ "~ >="¢ Views
Lo
% Transforms

~ Recent DICOM Activity | view Controllers

0 series added to database ® Volume Rendering

Ty CT_Thore Abcoro R

£\ Welcome to Slicer

Wizards

Developer Tools

Legacy 4
I; Testing 4
8 BRAINS ' 595 1 b R : 6: CT_Thorax_Abdome
Unspecified 4 RN —

MultiVolume Support 4
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Loading a DICOM volume

Select the Active Volume
6:CT_Thorax_Abdomen

» Help & Acknowledgement

> Active Volume 6: CT_Thorax_Abdomen
» Volume Information
~ Display

Lookup Table: F Grey

Interpolate: ¥
Window Level editor presets:

WL @ A

sL:40

W: 350 3| Manual W/L

Threshold: Off
-1434 =

» Histogram

Click on the Window Level
Preset CT-abdomen, or

adjust manually the Window
and Level using the Manual

WI/L slider
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... Slicer has a series of
window/level presets
available
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Loading a DICOM volume

£ Sicerts
File Edit View Help
ga Modules: | ® Volumes 2= Q. PO e 2 t - @ A fa -age

- Position the mouse cursor |
over the pin icon (leftto . o
the letter R) in the Red
Viewer to display the slice
menu. :

 Click on the Links icon &_ -
to link the slice controls
across all Slice Viewers.

* Click on the Eye icon to
display the three
anatomical slices in the
3D Viewer
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Loading a DICOM volume

(>4 licer 4.4
File Edit View Helo

The three anatomical
slices appear in the 3D
viewer.

Hold the right-mouse
button down in the 3D
Viewer, and move to the
cursor up and down to
zoom in and out

©2014 Surgical Planning Laboratory, ARR
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Loading a DICOM volume

5 3D Slicer 440

®

folle s

File Edit View Help
ga & & Modules: . ®Volumes (=009 O @ i 2 t-BwRl+-@®
:/ 30Slicer

Hold the left-mouse ’ -
button down in the 3D - K

Viewer and move the
cursor lefft and right to -
rotate the volume

~ Data Probe

Slice Annotations:| |

F 2
B: 6: CT_Thorax_Abdomen'y,

©2014 Surgical Planning Laboratory, ARR Slide 39



Loading a DICOM volume

[=@r=]
File Edit View Help

| 8a & 'Modules: \[.Volumes ¢]-,°, 0,3 Hit-8 = |+ 83

30Slicer

* Help & Acknowledgement
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Loading a DICOM volume

5 3D Slicer 440
File Edit View Help
& |Modules:

! = 3DSlicer
4

» Help & Acknowledgement

« | @ Volumes :

Active Volume 6: CT_Thorax_Abdomen
* Volume Information

~ Display
Lookup Table:| IE  Grey s
Interpolate: ¥

Click on the Slicer layout menu
icon, and select the Conventional
Widescreen layout

~ Data Probe

Slice Annotations:| & |

[l One-Up Quantitative
[ Red slice only

L[ Side by side

{E Four by three slice
LM Four by two slice

B Three by three slice

slice only
lice only
D

slice

w

e

‘e Widescreen 4
e Grid 4
wver three

Jver Three Quantitative
er four

ar Two

*"| B: 6: CT_Thorax_Abdomen!
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Loading a DICOM volume

& S0 Sicerda0 = =
File Edit View Help

| &a £ Modules:

@ Volumes =00 IP 0w v B t-|B ™ a+- @

[ ~ Data Probe

Slice Annotations: | # | _ g

) | )

F e

B 5. Y /
o AN RS g
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3D Interactive exploration of
thoraco-abdominal CT data
using Volume Rendering
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Volume Rendering

®

B 30 sicersa0 [E=mjr=n =)
File Edit View Help
ga & Modules: .| ®Volume Rendering ¢] -0 Q0 9@ & t-E W Rl @@

ex M1

@ 3DSlicer

» Help & Acknowledgement

“+ Volume: [6: CT_Thorax_Abdomen ¢
* Inputs

~ Display

~ Data Probe

Slice Annotations:| ' |
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Volume Rendering

B 30 sicersa0 [E=mjr=n =)
File Edit View Help
ga & Modules: .| ®Volume Rendering ¢] -0 Q0 9@ & t-E W Rl @@

ex M1

@ 3DSlicer

» Help & Acknowledgement

Volume: [6: CT_Thorax_Abdomen
* Inputs

o

~ Display

~ Data Probe
Slice Annotations:| ' |
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Volume Rendering

/5 3D Slicer
File Edit View Help
ga & |Modules: -\[.Vulume Rendering 3]

@ 3DSlicer

I » Help & Acknowledgement
L

®

fo|é =

Et- 8w A+ @@

“+ Volume: [6: CT_Thorax_Abdomen
[» Inputs

I ~ Display
Preset:
Shift:
Crop:

Rendering:

» Advance
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Volume Rendering

B3 cer
File Edit View Help
|&a & Modules:

e 3DSlicer

[ » Help & Acknowledgement
I

®

fo & ]

@ Volume Rendering " Q009 O & i 2 BRI t~18 % R +-@@

+* Volume: [6: CT_Thorax_Abdomen
[ * Inputs

[ ~ Display

Preset:  |®CT-Cardiac3
Shift: G
Crop: Enabl <+ Display ROI
Rendering:[VTK CPU Ray Casting

[ » Advanced...

|~ Data Probe
Slice Annotations:
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Volume Rendering

S g
File Edit View Help
ga & Modules:

e 3DSlicer

<+ Vo

fo & ]

® Volume Rendering

owledgement

: lG: CT_Thorax_Abdomen

[ * Inputs

[ ~ Display

Preset:  |®CT-Cardiac3
Shift: G
Crop: Enable <+ Display ROI
Rendering: [VTK CPU Ray Casting

[ » Advanced...

[ ~ Data Probe
Slice Annotations:| ' |
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Volume Rendering

& 3D Slicer4.40
File Edit View Help
% IModules: . |®Volume Rendering

@ 30Slicer

| » Help & Acknowledgement

®

- Vqume:i [6: CT_Thorax_Abdomen
[ * Inputs

| ~ Display

Preset: | ®CT-Cardiac3
Shift: -
Crop: Enable «+ Display ROI | #Fit to Volume
Rendering:‘VTK CPU Ray Casting

[ » Advanced...

Slicer displays the 3D rendered volume
of the CT_Thorax_ Abdomen dataset
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Volume Rendering

& 3D Slicer 440 (=S
File Edit View Help
£3 Modules: . ®Volume Rendering =0 Q0IP O @ & <

!b; 3DSlicer
v

| » Help & Acknowledgement

- Vqume:i 6: CT_Thorax_Abdomen
[ * Inputs

Preset: | ®CT-Cardiac3
Shift:

Enable «+ Display ROI #Fit to Volume

[+ Advanced...

Move the Shift slider
toward the right, to
shift the transfer
function and display

Lo

_ the aorta
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Volume Rendering

®

& 3D Slicer 440 ==
File Edit View Help
g £ |Modules: . ®Volume Rendering (=0 019 @ @ & < t-lE % |+~ @@

@ 30Slicer

‘ * Help & Acknowledgement

# Volume: |6: CT_Thorax_Abdomen
[ > Inputs

\ ~ Display

Preset: | ®CT-Cardiac3
Shift:
Crop: Enable “+ Display ROI | #Fit to Volume |
Rendering: \VTK CPU Ray Casting ¢\

[+ Advanced...

The volume rendered image
of the aorta and rib cage

appears in the 3D viewer
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N Volume Rendering

ESESE|

Eit-8 ™ n| +- @@

~ Data Probe
Slice Annotations:| # |

L
F
B
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Volume Rendering

&3

. (BN R =
File Edit View Help
g £ Modules: . ®\Volume Rendering ¢] =0 Q0|9 @ @ & ¢ B t-8 @ |+ @

»)

~ Data Probe
Slice Annotations:
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Volume Rendering

T 3o sicerda
File Edit View Help
F=) & Modules:

@ 3DSlicer

» Help & Acknowledgement

J
# Volume: [6: CT_Thorax_Abdomen ’l
» Inputs l
]

~ Display
Preset:  |®CT-Cardiac3 :
Shift: 0

(BN R =

© Volume Rendering ¢] -0 Q|
e®
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Volume Rendering

&3 cer
File Edit View Help
|1&a & Modules:

g 3DSlicer

[ * Help & Acknowledgement
I

=3 =T

© Volume Rendering =00 19O @
o®

“+ Volume: [6: CT_Thorax_Abdomen ¢
[ * Inputs
[ ~ Display

Preset: [ @ CT-Cardiac3 B

Shift:

Crop: ¥ Enable «* Display ROI | #Fit to Volume |
Rendering:|VTK CPU Ray Casting B
[ * Advanced...
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Volume Rendering

(G =
File Edit View Help

ga Za |Modules: | ®Volume Rendering ¢] "0 Q|9 w i < Eilt-1E = 5| +-@

[ » Help & Acknowledgement

“+ Volume: [6: CT_Thorax_Abdomen
[ * Inputs

[ ~ Display

Preset:  |®CT-Cardiac3

Shift: ¢

Crop: * Enable # Display ROI

Renderingg asting =]
dvanced...

The region of interest
appears in the 3DViewer

B
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Volume Rendering

®

D Slicer
FI EdtVew HIp
g3 B4 £a Modules ® Volume Rendering 2= Q PO a Eillt~@ W S -@e

Click on the eye icon in the red
viewer to turn on the visibility of
the grayscale images, and

position the ROI around the left
and right kidneys using the ROI
controls in the 2D anatomical
views and in the 3D viewer

L
F
B
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Volume Rendering

& 30 Slicer 440 =l =s
File Edit View Help
£a |Modules: | ®Volume Rendering =0 019

@ 3DSlicer

[ Help & Acknowledgement

«* Volume: |6: CT_Thorax_Abdomen
‘ * Inputs

| ~ Display

Preset: ‘ @ CT-Cardiac3

Shift: ’
Crop: ¥ Enable # Display ROI #Fit to Volume

Renderina: VTK CPU Rav Castina

Click on the eye icon to
display the volume
rendered image of the
Kidney

.
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Volume Rendering

& 3D Slicer 440 o &=
File Edit View Help
& |Modules: . |®Volume Rendering :

!h’ 3DSlicer
4

\ * Help & Acknowledgement

# Volume: 6: CT_Thorax_Abdomen

‘ * Inputs

\ ~ Display

Preset: | ®CT-Cardiac3 :
Shift: 0

Crop: ¥ Enable # Display ROI 4 Fit to Volume

Rendering:\VTK CPU Ray Casting

Slicer displays the volume
rendered image of the left
Kidney

Slice Annotations:|
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Volume Rendering

& 3DSlicer440 [od ==
File Edit View Help
Za |Modules: | ®Volume Rendering ™ 0019 O @ i

B t-8 ™+ @

\!5’ 3DSlicer
4

[ * Help & Acknowledgement

# \lolume: |6: CT_Thorax_Abdomen
‘ * Inputs

[ ~ Display
Preset: [ @ CT-Cardiac3 s
Shift: 0
Crop: ¥ Enable # Display ROI #Fit to Volume

. - | f ) ) f i ]1‘\::”;'.:;] lil]w/aé
Rendering: [VTK CPU Ray Casting o ] 4 .
‘ *» Advanced... I | 7 - .

Extend the ROl to the
right kidney
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Volume Rendering

3D Shicer 440 [ =8 =R
File Edit View Help
£ 'Modules: . ®Volume Rendering " Q0P O @ i <

o @1

@ 3DSlicer

| * Help & Acknowledgement

= \olume: ‘6: CT_Thorax_Abdomen
‘ * Inputs

[ ~ Display

Preset: [ @ CT-Cardiac3
Shift:
Crop: ¥ Enable # Display ROI 4 Fit to Volume .
Renderina: \VTK CPLI Rav Castina :

Slicer displays the KR
cropped volume rendered
images showing the left

and right kidney

B
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Volume Rendering

®

£ 3D Slicer 440

=5 TR =)
File Edit View Help
£ 'Modules: . ®Volume Rendering " Q0P O @ i < BRIt~ A Fe | 4~ a

o @1
@ 3DSlicer

| * Help & Acknowledgement

# Volume: 6: CT_Thorax_Abdomen
‘ * Inputs

[ ~ Display

Preset: | ®CT-Cardiac3
Shift:

Crop: ¥ Enable # Display ROI 4 Fit to Volume .
Renderina: VTK CPU Rav Castina 2

Click on File=>Close Scéne to
close the scene

Click on File>EXxit to quit Slicer

Slice Annotations:| ' |

L
F
B
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Part 2:
3D visualization of surface
models of the brain
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N 3D Data Loading and Visualization

S * Open the directory 3DVisualization_Monday_Dec1
a} data on the Desktop

. dataset? Head « Select the directory dataset2_Head

. datasets_Liver

. datasetd_Chest
> 1. Quantitativelmaging_Tuesday_Dec2

» Select the file MRHead_Scene.mrb
This file is composed of an MR scan of the brain and
3D surface reconstructions of anatomical structures.

The data are part of the SPL-PNL Brain Atlas

developed by Talos, Jakab, Kikinis et al. The atlas is

freely available for download at:
http://www.spl.harvard.edu/publications/item/view/2037
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3D visualization of surface models of the brain

®

4 | 3DVisualization_Monday_Decl mEE
4 | data
AWelcome to Slicer
. dataset2_Head
. datasetd_Chest ualization_Monday... > dataset2_ Head <[4
> | Quantitativelmaging_Tuesday_Dec2 e e
e Lodlekiy ™
— | | MRHead_Scent
# Cus| )=
| ~ Feedback| qu
sh .
3D|
item
We are al ’

submission v oe-careramy oo

See more at http://goo.gl/6BvcHm.

» About

* The Main Window

* Loading and Saving

* Display

~ Data Probe

Slice Annotations:| = |

Drag and drop the file Head_Scene.mrb into Slicer
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3D visualization of surface models of the brain

®

B 30 Slicer4.40 [ @ ]=]
File Edit View Help
g |Modules: . |© Models (=009 O @ i 2

]bi 3DSlicer

| » Help & Acknowledgement

Include Fibers Scroll to... o # |

Scene
] Add data into the scene

Choose Directory to Add| Choose File(s) to Add Show Options

v File Description
v .../data/datasetl_MR-Head/MRHead_Scene.mrb MRB Slicer Data Bundle *

| » Information

‘ ~ Display
Visible:
View: All
Clip:

Slice Intersections Visible: L Reset [ &OK | X Cancel

Slice Intersections Thickness: ; ‘ ‘ ‘ ‘

Click on OK to load the file MRHead Scene.mrb into Slicer
|

Edge Color: = #UUUUUU

| » Data Probe |

L ) 5cm

(]
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3D visualization of surface models of the brain :
Viewing th n

£ 3D Slicer 440

File Edit View Help

% IModules: . |®Models = QO
®

®

[ * Help & Acknowledgement

When the scene is finished loading, "
Slicer displays:

*a 3D model of the head in the 3D
Viewer, and

*anatomical MR slices of the
brain in the 2D Slice Viewers.

Color: #808080

Opacity: ‘ 5
Edge Visibility:

Edge Color: = #000000

[ * Data Probe
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3D visualization of surface models of the brain : Exploring
Slicer’ s functionality

800 |  ACPC Transform
File Edit View Help \ Add Scalar Volumes
&a |Modules: . [ Welcome to Sicer 2y 2::7”:‘3“;5
AtlasTests
@ Annotations BSpline Deformable Registration
3DSlicer A Data BSpline to deformation field
& DicoM @ Cameras
~ Editor Cast Scalar Volume
We | COTe toces ChangeTracker
A Scene Views Charpa
B €fieckerBoard Filter
—————————— 4 Transforms B Colors
iy Load DICOM Daf Il View Conizglaes Create a DICOM Series
© e Rendering & CropVolume
j @ Volumes Curvature Anisotropic Diffusion
|2\ Welcome to Siicer A Daa
To access the Models -~ oo
1 1 Wizards R Demon Registration (BRAINS)
—— | Informatics »| & DICOM
~ | Registration »|  DICOM to NRRD Converter
module. browse = [ N
b Quantification »  Diffusion Weighted Volume Masking
. Diffusion » DTIChallengeExplorer
- IGT »|  DTlexport
through the list of | o
3 Surface Models »|  DWI Joint Rician LMMSE Filter
Converters ,|  DWI Rician LMISE Fiter
__ | Endoscopy »|  DWito DTI Estimation
l I I Od u I eS Utilties \|  DWIto Full Brain Tractography
- Developer Tools » DWI Unbiased Non Local Means Filter
Legacy »| ~ Editor
Testing »| EMSegment Command-ine
Work in Progress | 1 EMSegmenter with Atas
1 [} without Atlas
Endoscopy
Event Broker

Data Probe

R

Execution Model Tour
Expert Automated Registration

Extract Skeleton

fiber_visibility_crash2438

Fiducial Registration

Foreground masking (BRAINS)

Gaussian Blur Image Filter

General Registration (BRAINS)

Gradient Anisotropic Diffusion

Grayscale Fill Hole Image Filter

Grayscale Grind Peak Image Filter

Grayscale Model Maker

Histogram Matching

Image Label Combine

Intensity Difference Change Detection (FAST)
Label Map Smoothing

Label Statistics

labelToggleBug2049

Linear Registration
Mask Scalar Volume
Median Image Filter
Merge Models
Model Maker
Model To Label Map
& Models
Multiply Scalar Volumes
MultiVolumeExplorer
MultiVolumelmporter
N4ITK MRI Bias correction
3€ OpenlGTLinkIF
Orient Scalar Volume
Otsu Threshold Image Filter
Otsu Threshold Segmentation
Performance Tests
PET Standard Uptake Value Computation
Probe Volume With Model
@ Reformat
RegAladin
Resample DTI Volume
Resample Image (BRAINS)
Resample Scalar Volume
Resample Scalar/Vector/DWI Volume
Rigid Registration
Robust Muliresolution Affine Registration
Robust Statistics Segmenter
RSNA2012ProstateDemo
RSNA2012Quant
RSNA2012Vis
B sample Data
Scene Import (Issue 2428)
Scene Views
SelfTests
Simple Region Growing Segmentation
SiiceLinkLogic
SiiceraMinute
slicerCloseCrashBug2590
Subtract Scalar Volumes
Threshold Scalar Volume
Tractography Display
Tractography Interactive Seeding
Tractography Label Map Seeding
Transform MRML Files to New EMSegmenter Standard
< Transforms
Vector Demon Registration (BRAINS)
Vector to Scalar Volume
View Controllers
ViewControllers Slice Interpolation Bug 1926
® Volume Rendering
@ Volumes
Voting Binary Hole Fillng Image Filter
WebGL Export
2\ Welcome to Slicer

¥
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3D visualization of surface models of the brain : Switching
to the Models Module

®

& 30 Slicer440 =)&)
File Edit View Help
g £ |Modules: . ©Models =0 0190 @ & < t- B R+ @@

& Slicer displays the GUI of the
» Help & Acknowledgement :MOdels module

Include Fibers « Scroll to...

= Scene

* hemispheric_white_matter.vtk 1.00

» left_eyeball.vtk m  1.00

= optic_chiasm.vtk 1.00

= optic_nerve_L.vtk 1.00

# optic_nerve_R.vtk 1.00 Y —— R 15002m

= optic_tract_L.vtk 1.00

= optic_tract_R.vtk 1.00 v

* right_eyeball.vtk H  1.00

= Skin.vtk 1.00

# skull_bone.vtk 1.00 P

- g
» Information | ] A
) -
~ Display I
¢ B

Visible: : \
View: Viewl > [ A
Clip: ; > 1
Slice Intersections Visible: N
Slice Intersections Thickness: | B VS
Color: #808080
Opbacitv: IS
» Data Probe |
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3D visualization of surface models of the brain : Basic 3D
Interaction

3D Slicer4.40
File Edit View Help
ga & Modules: . |®Models #‘ - Q.

* Help & Acknowledgement

Tnclude Fibers |, Scroll to... Ez

Position the mouse
in the 3D Viewer. L0

1.00

H 100
1.00

Hold down the left
mouse button and |
drag to rotate the
model.

wl

Color: #808080
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3D visualization of surface models of the brain : Viewing
Slices in the 3D Viewer

& 3D Slicer 440
File Edit View Help
&3 'Modules: \[OModeIs ¢] "0 Q9O a & «

[=l@s=]

kads - Axiat|m o B & @

@ 3DSlicer
- - & None

© | 0.00 /& None
@ vi\grayscale :

[ * Help & Acknowledgement

Include Fibers « Scroll to... (2]
= Scene
* hemispheric_white_matter.vtk 1.0
= left eveball.vtk 1.0

Click on the Slice Visibility
A icon

to display the Axial Slice in
the 3D Viewer

Color: = #808080
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3D visualization of surface models of the brain

Slicer adds a view of
the Axial slice in the
3D View.
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3D visualization of surface models of the brain : Viewing
Slices in the 3D Viewer

& 3D Slicer 440
File Edit View Help
g3 'Modules: \[OModeIs

®

==

C

st V DO RN X ]
& o) e-Loo[J@Nore |+

[ * Help & Acknowledgement F o l0.00 * & ‘None

@ o] B
Include Fibers . Scrolle™. Dl grayle

= Scene
= hemispheric_ile_matter.vtk

Click on the layout menu in
the toolbar, and select the
Conventional layout

[ ~ Display

Visible:

View: Viewl
Clip:

Slice Intersections Visible:

Slice Intersections Thickness: |

Color: = #808080
OOOOOO

LV I+ oulyival rrialiiily Lavuviatul y, AN INIUT 1 9



3D visualization of surface models of the brain

®

Select the model Skin.vtk o ‘, S
Click to expand the tab Display

Select the tab Color, and change the |
opacity of the model from 1.0 to 0.0.

Clip:
Slice Intersections Visible:

Slice Intersections Thickness:|1 px

* Representation

~ Color

Color: #ffddce

Opacity: 11.00
Edge Visibility:

Edge Color: = #000000

* Lighting

* Material

* Scalars

\ * Clipping
‘ » Data Probe: C:/Users/Frankie/AppData...ene/MRHeadecene.mrn?l‘ B: grayscale
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3D visualization of surface models of the brain

®

skin model opacity = 0.5
@ms..m

- UpuC_uau_tvin
* optic_tract_R.vtk
» right_eyeball.vtk

@ Bt 8™+ @

= skull_bone.vtk

| » Information

‘ ~ Display
~ Visibility
Visible: N
View: All
Clip:

Slice Intersections Visible:
Slice Intersections Thickness:|1 px

* Representation

~ Color

Color: C #ffddce
Opacity: g
Edge Visibility:
Edge Color: = #000000
» Lighting

* Material

» Scalars

| » Clipping \

‘ *» Data Probe: C:/Users/Frankie/AppData...ene/MRHead_Scene.mrm' grayscale
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3D visualization of surface models of the brain

®

The model of the skin becomes S
invisible in the 3D viewer.p===

(skin model opacity = 0.0)

Clip:
Slice Intersections Visible:
Slice Intersections Thickness:|1 px

* Representation

~ Color

Color: #ffddce J
Opacity: C 0.00 |
Edge Visibility:

Edge Color: = #000000 |
» Lighting

* Material

* Scalars

| » Clipping \

‘ *» Data Probe: C:/Users/Frankie/AppData...ene/MRHead_Scene.mrm[ B: grayscale
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3D visualization of surface models of the brain

B 30 Slicer4.40 EEE
File Edit View Help
28 & 'Modules: | ®Models " QO IPO @ i v

Click on the Slice Visibility icon |-
in the Green Slice Viewer to display
the Coronal Slice in the 3D Viewer.

|~ Display
~ Visibility
Visible:
View: All
Clip:
Slice Intersections Visible:
Slice Intersections Thickness: 1 px K

* Representation

~ Color
Color: [ #ffddce )
Opacity: [0.00 7/
Edge Visibility:
Edge Color: = #000000 )
» Lighting « & <\ ~Coronal ¢ EE % @ 3
* Material 0w @ [None
o _‘ e[
4 ‘ ‘3 \ @) a
Scalars Ly X ) o ).00 }: i ‘Ncne :
|» Clipping ‘ ! I.' = Sy /S @ .@lgrayscale

[ » Data Probe: C:/Users/Frankie/AppData...ene/MRHead_Scene.mrmI B: grayscale
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3D visualization of surface models of the brain

®

The Axial and Coronal
Slices are displayed in
the 3D Viewer.

= skull_bone.vtk

| » Information

[~ Display
~ Visibility
Visible:
View: All
Clip:
Slice Intersections Visible:
Slice Intersections Thickness: 1 px

» Representation

~ Color

Color: #ffddce
Opacity:

Edge Visibility:
Edge Color: = #000000

» Lighting

* Material

* Scalars

* Clipping

o
2
o
e
o
o
]
(@]
Q
=
-
1]
g
<
E
3
8
=
a
b
o
5]
o
o
S
8
»
]
o
2
=
pl
=
[}
o
‘Q.
@
o
3
2
3
3
3 a
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®

3D visualization of surface models of the brain

& 30 Sl [E=EE=R )
File Edit View Help
£a Modules: . |®Models

-~ Select the 3D model skull_bone.vtk in
the Model Hierarchy

UpLC_uan L 1u
= optic_tract_R.vtk 1.00
* right_eyeball.vtk H 100
=+ Skin.vtk

0.00
——> I B 100

e ~ Click to expand the tab Display

~ Display

~ Visibility
/ d ' Click to expand the tab Visibility

Slice Intersections Thickness:|1 px

» Representation

~ Color

L] -
s Check the option Clip
Opacity: 1.00 .
Edge Visibility:
Edge Color: = #000000
» Lighting

» Material

» Scalars

* Clipping

» Data Probe: C:/Users/Frankie/AppData...ene/MRHead_Scene.mrm| [ty
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3D visualization of surface models of the brain

®

Browse through the o
coronal slicesto =~ "%
expose the 3D
model of the white
matter, and the left
and right optic
nerves.

Color:
Opacity:

Edge Visibility:
Edge Color: = #000000
» Lighting

* Material

* Scalars

| » Clipping \

» Data Probe: C:/Users/Frankie/AppData...ene/MRHeadecene.mrmI: B: grayscale
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3D visualization of surface models of the brain

®

Uncheck the option ‘visible’ to —=
make the skull invisible. :

4

\ » Help & Acknowledgement

Include Fibers . Scroll to... RE

= Scene
* hemispheric_white_matter.vtk 1.00
= left_eyeball.vtk H 100
# optic_chiasm.vtk 1.00
» optic_nerve_L.vtk 1.00
= optic_nerve_R.vtk 1.00
= optic_tract_L.vtk 1.00
» optic_tract_R.vtk 1.00
» right_eyeball.vtk m 100
= Skin.vtk 0.00
= skull _bone.vtk B  1.00

|+ Information

\ ~ Display
~ Visibility
ﬁ Visible:
View: All S
Clip: o
Slice Intersections Visible:
Slice Intersections Thickness:[l px 5

» Representation N
AL

~ Color O ‘
Color: ( Ediiiing
Opacitv: 21100 15

\ » Data Probe: C:/Users/Frankie/AppData...ene/MRHead_Scene.mrm| By

LTt 10em S Ll 10cm

(:]
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3D visualization of surface models of the brain

®

Scroll the Coronal Slices to display the

hemispheric white matter model in the
context of the image data in the 3D viewer.

= Scene

* hemispheric_white_matter.vtk 1.00
= left_eyeball.vtk H 100
= optic_chiasm.vtk 1.00
* optic_nerve_L.vtk 1.00
= optic_nerve_R.vtk 1.00
= optic_tract_L.vtk 1.00
* optic_tract_R.vtk 1.00
* right_eyeball.vtk m 100
= Skin.vtk 0.00
* skull_bone.vtk o 1.00
[ » Information \
| ~ Display |
~ Visibility
Visible:
View: All
Clip: v

Slice Intersections Visible:
Slice Intersections Thickness:|1 px 3

» Representation

~ Color
Color: Ediiiiid J

Obacitv: 100 2
\ » Data Probe: C:/Users/Frankie/AppData...ene/MRHeadecene.mrml ;: grayscale
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3D visualization of surface models of the brain

®

Select the hemispheric white matter model called S
hemispheric_white _matter.vtk

Turn off its visibility.

/" = hemispheric_white_matter.vtk
= left_eyeball.vtk |
# optic_chiasm.vtk
* optic_nerve_L.vtk
= optic_nerve_R.vtk
= optic_tract_L.vtk
* optic_tract_R.vtk
* right_eyeball.vtk | |
= Skin.vtk
<~ skull_bone.vtk

» Information

~ Display
~ Visibility
H Visible:
View: All
Clip:
Slice Intersections Visible:
Slice Intersections Thickness:|1 px

» Representation

~ Color
Color: Eiiiiid

Obacitv: 111.00 2] -
» Data Probe: C:/Users/Frankie/AppData...ene/MRHead_Scene.mrm| [y

©2014 Surgical Planning Laboratory, ARR Slide 83



3D visualization of surface models of the brain

|

Slicer displays the optic nerve,
optic chiasm and optic tracts
overlaid on the MR images of
the brain.

®
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3D visualization of surface models of the brain

®

K 30 Slicer4.40 (== ==
File Edit View Help

ga & & Modules: . ©Models = QOO @ & < tE R+ @@

ox M1
E 3DSlicer
v

» Help & Acknowledgement

Include Fibers Scroll to... []®

Slicer displays a closer = s
view of 3D anatomical i
structures overlaid on 2D .
MR slices i

> Information

~ Display

- Visibility

Visible:

View: All
Clip:

Slice Intersections Visible:

Slice Intersections Thickness:|1 px

» Representation

\
~ Color {
Color: ( #ffff
Obacitv: 2l1.00 21
» Data Probe: C:/Users/Frankie/AppData...ene/MRHead_Scene.mrm| EEirmas -

L T 10cm
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®

Close the existing scene and all its data

& 3D Slicer 440

Edit View Help
|ta Add Data Ctrl+0 |
|5 DICOM |

SeleCt F i Ie->C Iose Download Sample Data

% Save Ctrl+S

Scene

EXIT

=-Scene
* |eft_eyeball.vtk
= optic_chiasm.vtk
= optic_nerve_L.vtk
= optic_nerve_R.vtk
= optic_tract_L.vtk
* optic_tract_R.vtk
= right_eyeball.vtk
= Skin.vtk

skull_bone.vtk

, Scroll to...

» Information

This removes any dataset
previously loaded into Slicer.

Select File>Exit to exit the
software

= Q.

H  1.00
1.00
1.00
1.00
1.00
1.00

0.00
1.00

— 100 =
ad_Scene.mrm| E%

== )
PO s s Hit- 8w +-@@
ox M1

10cm

(%]
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3D Visualization of DICOM images

Interactive user-interface to

load and manipulate DICOM
volumes, labelmaps and 3D
models

User-defined 3D view of the
anatomy
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ﬁ' www.slicer.org

3051 A multi-platform, free and open source software package for
DSlicer visualization and medical image computing

Slicer Wiki

3DSlicer

About Slicer \ Powerful processing. “ Streamlined interface. ” fxtensible platform.

»Introduction
»Acknowledgments

»Contact Us
Resources
Download Slicer 4 is the latest version of 3D Slicer, a free, comprehensive software platform for medical image analysis and visualization developed with NIH support.
WNI0as
3D Slicer is distributed under a permissive BSD-style open source license. It has a thriving user and developer community.
»For Users

»For Developers
»Commercial Use
*NCIA

Pre-compiled binaries

Windows Mac OS X Linux
»Publication DB
44064 bitnstaller 44064 bitarchve
»Image Gallery 64bit 141102
»Slicer Community bl 22774 224.018) 25774 (244 308)
release
»Source Code 430 320t insaller
. . a2bit 20120006
»Licensing 2248 157200)
»Mailing Lists
: nighty 64 bitnstaller nighty 64 bt archive.
»Web Archive cabi Pk vt
23765 224 0U8) 23785 244.308)
nightly
build

nightly 32 bt installer
20131124

32 bit
22717 (159 01B)

The community of Slicer developers is proud to announce the release of Slicer 4.2. Find out more...

Webinar: Introduction to Slicer 4.1

Content of this site is Copyright 2012 BWH and 3D Slicer contributors, unless otherwise noted.
Contact webmaster@bwh.harvard.edu for questions about the use of this site's content.
See here for more information about the web infrastructure.
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